
July 2003 Telelogic Tau

Chapter
5 Tutorial: TTCN Suite 

Basics (on UNIX)
This tutorial is intended as an easy introduction to the TTCN suite 
for the newcomer. It is also assumed that you have some basic 
knowledge about UNIX. In addition, to find the TTCN suite mean-
ingful to use, you have to understand TTCN.

Note: UNIX version

This is the UNIX version of the tutorial. The Windows version 
can be found in chapter 4, Tutorial: TTCN Suite Basics (in Win-
dows).

Note:

This document is a TTCN suite primer and is not intended to 
provide a tutorial on TTCN. The volume TTCN Suite Method-
ology Guidelines introduces some basic TTCN features present-
ed with the aid of a simple example.
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Purpose of This Tutorial
The purpose of this tutorial is to make you familiar with the basic func-
tions of the TTCN suite. The sections in this chapter are to be read se-
quentially. You will start by setting up the TTCN suite environment. 
Then you will create a TTCN test suite, edit the tables in the test suite 
and apply some basic the TTCN suite tools.

It is assumed that you know how to use UNIX but that you have no or 
little previous knowledge about the TTCN suite. However, to under-
stand the full use of the TTCN suite, you should have knowledge of 
TTCN. The volume TTCN Suite Methodology Guidelines introduces 
some essential TTCN features, presented with the aid of a simple exam-
ple.

Setting Up the TTCN Suite Environment
It is assumed that the TTCN suite (or Telelogic Tau) has been installed 
correctly, according to the instructions in the Installation Guide. The 
Telelogic Tau installation directory is pointed out by the environment 
variable $telelogic. This variable has to be set correctly in your 
UNIX environment.

1. The TTCN suite commands are made available if you add the Tele-
logic Tau bin directory to the environment variable PATH:

setenv PATH ${PATH}:$telelogic/bin

2. Also set the environment variable MANPATH to include the TTCN 
suite and the X11 man directories, to make the manual pages avail-
able:

setenv MANPATH \ 
${MANPATH}:$telelogic/itex/man:$telelogic/X11/man

If you type man itex, the UNIX manual entry for the TTCN suite will 
be displayed. It describes the switches that may be used to set the default 
settings of the dialog options.

To be able to use the on-line help, you need an HTML viewer, either 
Netscape or Internet Explorer. To select the HTML viewer to use, see 
“Customizing the On-Line Help” on page 290 in chapter 4, Managing 
Preferences, in the User’s Manual.
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 Starting the TTCN Suite
Starting the TTCN Suite
Once the TTCN suite software has been installed, you can start it from 
a UNIX shell tool (e.g. an X-term) by the command itex:

• Type itex to start the TTCN suite.

After a few seconds, the Organizer window is displayed. The Organizer 
is the main window from which you have access to the tools in the Tele-
logic Tau environment. 

A welcome window, where you may read the licensing agreement for 
Telelogic Tau, will also be displayed. The window disappears as soon 
as you click the Continue button or perform any action in the Organizer.

The Organizer consists of a main window and a log window. In the main 
window, five areas – known as chapters – are displayed by default:

• Analysis Model
• Used Files

Figure 29: The Organizer main window
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• SDL System Structure
• TTCN Test Specifications
• Other Documents

You may freely use these chapters to hold a number of documents and 
chapters may also be renamed, deleted and created – the actual use is a 
matter of personal taste. 

More information about customizing the chapters can be found in “Cus-
tomizing the Organizer Chapters” on page 51 in chapter 3, Tutorial: The 
Editors and the Analyzer, in the SDL Suite Getting Started.
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 Creating a TTCN Test Suite Document
Creating a TTCN Test Suite Document

What You Will Learn
• To set the source and target directory
• To create a new test suite

Setting the Source and Target Directory
You will begin by setting the source and target directory in the Organiz-
er. The source directory is where your new documents will be saved by 
default. The target directory is where generated files are put. Both of 
these directories must already exist – they cannot be created in the Or-
ganizer.

The Set Directories dialog is opened, and you may change the 
source and target directories.

1. Double-click the source directory icon in the Organizer window.

– You may also select the source directory icon and then select 
Edit from the Edit menu in the Organizer or select Set Directo-
ries from the File menu.
July 2003 Telelogic Tau 4.5 TTCN Suite Getting Started gs-t3 69



Chapter 5 Tutorial: TTCN Suite Basics (on UNIX)
2. Select the source directory by writing the path in the text field or by 
browsing in the dialog that is opened when you click the folder but-
ton. Make sure that you have write access to the directory.

3. In the same way, you can change the target directory. 

4. Click OK in the Set Directories dialog.

Figure 30: The Set Directories dialog
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 Creating a TTCN Test Suite Document
Creating a New Test Suite
When you have set the source and target directories, you should create 
a new TTCN document of type test suite or modular test suite:

1. Select the chapter TTCN Test Specification in the Organizer.

2. Select Add New from the Edit menu in the Organizer.

The Add New dialog is opened. In the dialog you should set the doc-
ument type and name.

3. Select TTCN and Test Suite or Modular Test Suite in the New docu-
ment type list. 

4. Type Example_A in the New document name field.

5. Make sure that the option Show in editor is selected.

6. Click the OK button.

A new TTCN document of type test suite or modular test suite is 
created. At the same time, a TTCN icon is created in the Organizer. 
After that, the TTCN Browser window is opened. The Browser will 
show the new test suite in a collapsed format.

Figure 31: Add New dialog
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Figure 32: The Browser window with a collapsed test suite
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 Using the Browser
Using the Browser

What You Will Learn
• To expand and collapse the test suite
• To add TTCN tables to the test suite

Expanding and Collapsing the Test Suite
The Browser displays the test suite in a collapsed format, which is indi-
cated by the three dots after the items in the test suite. 

To expand the entire test suite: 

1. Select the top node in the Browser, that is Example_A.

2. Select Expand Tree from the View menu.

– It is also possible to open the pop-up menu on Example_A and 
select Expand Tree from it.

All the collapsed items in the Browser are expanded.

Shortcut:
• <Shift+e> (Expand Tree)
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You may also want to deselect the test suite:

3. Deselect the test suite by selecting Deselect All from the pop-up 
menu.

To collapse the test suite:

• Open the pop-up menu on Example_A and select Collapse from it.

Figure 33: The Browser window with the expanded 
modular test suite and no selected items

Shortcut:
• <Ctrl+\> (Deselect All)
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 Using the Browser
Note that Expand and Collapse only work on a single selection. If more 
than one item or if no item is selected, the Collapse, Expand and Expand 
Tree commands are dimmed. In the following, it is assumed that the test 
suite is completely expanded in the Browser.

You should also note that items in bold font represent the static (struc-
tural) parts of the test suite that cannot be opened or edited. The items 
in normal, plain font represent TTCN tables, which of course can be 
opened and edited.

Building a Test Suite
You are now going to add a simple TTCN table to your test suite.

To add a PCO Type to Example_A in the Browser:

1. Select PCO Type Declarations in the Declarations Part.

2. Select Add from the Browser Edit menu.

Note that Add only works when a single item is selected.

A PCO type with the temporary name NoName is added in the PCO 
Type Declarations list.

3. Rename the PCO type NoName by opening the pop-up menu on 
NoName and selecting Rename from it.

It is now possible to type the new name. In this example we will call 
the PCO type LOWER_PCO.

Shortcut:
• c (Collapse)
• e (Expand – does not have the same effect as Expand Tree)
• <Shift+e> (Expand Tree)

Shortcut:
• <Ctrl+Shift+Ins> (Add)

Shortcut:
• First click on NoName, then press r (Rename).
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4. In a similar manner as described above, you should also add the fol-
lowing items:

– A TTCN PCO called L
(Declarations Part > PCO Declarations)

– A TTCN PDU called SEND 
(Declarations Part > PDU Type Definitions > TTCN PDU Type 
Definitions)

– A TTCN PDU called RECEIVE 
(Declarations Part > PDU Type Definitions > TTCN PDU Type 
Definitions)

– A TTCN PDU constraint on the SEND PDU called S1
(Constraints Part > PDU Constraint Declarations > TTCN 
PDU Constraint Declarations)

– A TTCN PDU constraint on the RECEIVE PDU called R1
(Constraints Part > PDU Constraint Declarations > TTCN 
PDU Constraint Declarations)

– A test case called TEST_CASE_1
(Dynamic Part > Test Cases)

– A test step called TEST_STEP_1
Dynamic Part > Test Step Library)
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 Using the Browser
The next step is to edit the tables that you just added.

Figure 34: The Browser window showing some of the newly added items
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Using the Table Editor

What You Will Learn
• To open the Table Editor
• To edit the contents of a table

Opening the Table Editor
The Table Editor window is opened when you double-click on a table 
in the Browser window.

• Double-click the test case TEST_CASE_1.

The test case table is opened in the Table Editor window.

Figure 35: The test case TEST_CASE_1 which has not yet been edited
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 Using the Table Editor
Editing the Test Case Table
As you can see, the TEST_CASE_1 table, or any other table, consists 
of fields where text may be inserted and edited. You are now going to 
edit the contents of TEST_CASE_1:

1. Click in the Purpose field and type some text, for example: 
This is an example test case for the TTCN tutorial.

2. Type some text in the Description field, e.g. Example test case.

– Instead of clicking the mouse to set the input focus in the De-
scription field, you may also press <Ctrl+Down arrow> until 
the cursor has reached the Description field.

It is also possible to type text in the other fields but you do not have 
to do that in this tutorial. Note that the Group field is not editable. 
The contents of this field is always kept updated by the TTCN suite 
from the Browser structure.

3. Press <Ins> or <Insert>.

A new, automatically numbered, empty line is added to the body of 
the table.

4. Type L! SENT in the Behaviour description field of the new line.

5. Type S1 in the Constraints Ref field.

6. Press <Ins> or <Insert> to add another new line.

7. Type +TEST_STEP_1 in the Behaviour Description field of row 2.

Note that the text is automatically indented.

Note:

The misspelling of SEND is intentional!
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Copying and Pasting Text and Table Rows

Before you close the editor you may want to try to copy and paste text 
and rows in the table: 

• If you only want to copy text, you simply select and copy it, either 
by a menu choice or shortcut. To paste the text, you can either use a 
menu choice or shortcut.

• If you want to copy an entire row in the body of a table, you select 
it by pressing <Ctrl> while at the same clicking in the row. (A row 
in a dynamic behaviour table is selected if you click in the Nr col-
umn). When the row has been selected you can press <Ctrl+c> to 
copy it. You paste it with <Ctrl+Meta+v> (to paste after selected 
row) or <Ctrl+Shift+v> (to paste last in the body of the table).

Figure 36: The test case TEST_CASE_1 when it has been edited.
The misspelling of “SEND” is intentional.
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 Using the Table Editor
When you have finished copying and pasting, make sure that the con-
tents of the table are exactly as in Figure 36.

Closing the Table Editor

• When you have edited TEST_CASE_1, close the table from the File 
menu.

Completing the Test Suite
Now you should edit the other tables that you have already added to the 
test suite. Do this in a similar manner as described above, by using the 
tables in the following figures as models.

1. Edit the tables in the Declarations Part of the test suite, that is the 
PCO type LOWER_PCO, the PCO called L and the PDUs called 
SEND and RECEIVE:

Shortcut:
• <Ctrl+x> (Cut a row)
• <Ctrl+c> (Copy a row)
• <Ctrl+v> (Paste a row)
• <Ctrl+Meta+v> (Paste After)
• <Ctrl+Shift+v> (Paste Last)
• <Ctrl+Right arrow> (moves the input focus right)
• <Ctrl+Left arrow> (moves the input focus left)
• <Ctrl+Down arrow> (moves the input focus down)
• <Ctrl+Up arrow> (moves the input focus up)

Note:

There are two paste buffers: one for plain text and one for table 
rows.

Figure 37: The PCO type LOWER_PCO
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Figure 38: The PCO L

Figure 39: The PDU SEND

Figure 40: The PDU RECEIVE
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 Using the Table Editor
2. Edit the tables in the Constraints Part of the test suite, that is the 
PDU constraints called S1 and R1:

Figure 41: The PDU constraint S1

Figure 42: The PDU constraint R1
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3. Edit the test step called TEST_STEP_1 in the Dynamic Part of the 
test suite:

§When you add row 2 it is automatically indented, however, in this 

case it should not be. To decrease the indention:

– Select the entire line by clicking in the Nr column. Then select 
Decrease Indent from the Edit menu.

(The shortcuts are <-> and <+> on the right-hand keypad.)

4. Close all Table Editors when you have finished editing.

5. Save the test suite by selecting Save in the File menu. A Save As di-
alog is displayed.

6. Click OK.

Figure 43: The test step TEST_STEP_1
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 Analyzing the Test Suite
Analyzing the Test Suite

What You Will Learn
• To analyze a test suite
• To find errors

Analyzing the Test Suite
You are now going to analyze the test suite:

1. Select Analyze from the Browser Tools menu.

The Analyzer dialog is opened. You do not have to change the set-
tings in this tutorial.

2. Click Analyze.

The log window is opened. If you have edited the test suite as de-
scribed above, the log should show a single error message:

Figure 44: The Analyzer dialog
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The log text means that there is an error in line 1 of the Behaviour 
Description of the test case dynamic behaviour table called 
TEST_CASE_1.

Finding and Correcting the Error
To find the erroneous table:

1. Select the test case name in the log.

Figure 45: The TTCN suite log window showing one error

Figure 46: Selecting text in the TTCN suite log
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 Analyzing the Test Suite
2. Select Find Table from the Browser Tools menu.

The table will be found and displayed. In the first behaviour line you 
can see that you have written SENT instead of SEND. 

Note that the error line is marked in red. In the Browser, the errone-
ous table is also marked with a red bar.

3. Correct the error, i.e. change SENT to SEND.

4. Analyze the table by selecting Analyze from the Table Editor Tools 
menu.

You will now have a small test suite that is syntactically correct. 
This means that the red markings will disappear.

You may now close the table editor and log windows.
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Saving a TTCN Test Suite Document

What You Will Learn
• To save a TTCN document 
• To change its file name and/or its format

Save As Document
When you want to save a newly created document into a file, you must 
make a number of choices in the Save As operation:

1. Select Save As from the File menu in the Browser.

2. Select Binary (TTCN-GR) or Text (TTCN-MP).

.

Figure 47
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 Saving a TTCN Test Suite Document
3. If you chose Binary, you need to select None, Gzip or Compress.1

4. Select a file name.

5. Press Save As.

At the same time, the TTCN icon in the Organizer is associated with 
the specified file name.

Save Document
To save a document you can use either the Save Document item in the 
File menu of the Browser, or use the left most button in the toolbar of 
the Browser. The Save Document operation saves the document on disk 
with the same file name and format as before. If you try to save a docu-
ment which has no file name assigned yet, the Save As operation will be 
initiated instead.

1. For maximum compatibility, the None selection should be used. The Gzip selec-
tion is preferred over Compress, both for portability and performance.
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Creating TTCN Tables in Other Ways
The methods described below make it faster and more efficient to create 
TTCN tables. They also avoid annoying spelling errors and reduces the 
amount of text that needs to be typed.

What You Will Learn
• To create a table by copying and pasting
• To create a table by using the Data Dictionary menu
• To delete a table

Copying and Pasting
You shall now practice another way of creating a TTCN table, namely 
by copying and pasting it.

1. Find the PDU called SEND in the Browser.

2. Copy the SEND PDU by using the popup menu.

3. Find the PDU Constraint called S1. 

4. Open the pop-up menu on S1 and select Paste Before from it.

The SEND copy is pasted before S1.

Editing the New Table

1. Open the new SEND table.

The Table Editor window is opened displaying the table. As you can 
see, the PDU Type field and the Field names are filled in. Now you 
just have to change the name and insert values in Field_1 and 
Field_2.

2. Type a new name in the Constraint Name field, e.g. S2.

3. Give Field_A the value 3 and Field_B the value TRUE in the Field 
Value column.

4. Analyze the entire test suite as described in “Analyzing the Test 
Suite” on page 85.
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Using the Data Dictionary
This section contains an example of an efficient way of creating test cas-
es. Start by creating a new test case:

1. Create a new test case.

2. Name the test case, for example TEST_CASE_2.

3. Open the test case.

4. Select Add Send Statement from the Table Editor Data Dictionary 
menu. The Add Send dialog is opened.

5. Click on S2 in the Constraints list.

6. Click OK.

A send statement has now been automatically generated.

7. Select the generated line in the Table Editor by clicking in the Nr 
column.

Figure 48: Add Send dialog
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8. Select Add Attach Statement from the Table Editor Data Dictionary 
menu. The Add Attach dialog is opened.

There is only one test step available (i.e. TEST_STEP_1) so this will 
be automatically selected.

9. Click OK.

A new line has been added to the table.

Deleting the Tables
For the remainder of the tutorial you will not need the two tables that 
you have just created. You should therefore delete them.

1. Select Deselect All from the pop-up menu in the Browser.

2. Select TEST_CASE_2.

3. Select the PDU Constraint S2, while at the same time pressing 
<Ctrl>.

4. Select Delete from the Edit menu. The items are deleted.

Figure 49: Add Attach dialog
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 Selecting Browser Items
Selecting Browser Items
The Selector is a tool that you may use when you want to make selec-
tions of Browser items. Before you apply the Selector, the Browser 
must already contain a selection.Then you can specify, with the Selec-
tor, if you want to increase, decrease or replace the existing selection.

Based on the selections in the Browser, you can make sub Browsers. A 
sub Browser works as the normal TTCN Browser, but it does not con-
tain the entire test suite – only selected parts.

What You Will Learn
• To use the Selector tool
• To create a sub Browser

Selection 1
Suppose that you wish to select all the tables in the test suite that refer-
ence the PDU called SEND:

1. Deselect the entire test suite.

2. Select the single PDU called SEND.

3. Select Selector from the Browser Tools menu.

The Selector dialog is opened:
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4. Select the Extend option in Select Mode.

5. Choose the Referenced by option in the Relations box.

You do not have to change any other options.

6. Click the Select button.

Now take a look at the Browser. You should see that not only is the 
SEND PDU selected but also the constraint S1 and the test case 
TEST_CASE_1. Only these objects reference the SEND PDU. (You 
may have to scroll the Browser to see them all.)

Figure 50: The Selector dialog
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Selection 2
As another example, suppose that you wish to find all behaviour tables 
that have the character 1 included in their identifier and have a PASS 
verdict in the table:

1. Select the entire test suite.

2. Select Selector from the Browser Tools menu.

The Selector dialog is opened.

3. Type 1 in the Name restriction field.

This means that the names of the tables that you want to select 
should include the character 1.

4. Select Test Case Dynamic Behaviour, Test Step Dynamic Behaviour 
and Default Dynamic Behaviour in the Type Restriction box. 

5. Type PASS in the Content restriction field.

This means that there must be at least one occurrence of the word 
PASS in the selected tables.

6. Select Restrict in the Select mode box.

In other words, the intention is to select all behaviour tables that 
have a 1 in their names and that have a PASS substring in the con-
tents of the table.

The Analyze status and Relations options should not be set.

7. Click the Select button.

Only TEST_STEP_1 is selected in the Browser window.

Selection 3
Compare the result of the selection above with the following:

1. Select the entire test suite.

2. Apply the Selector with almost the same options as described 
above.

– The difference is that you should remove PASS from the Con-
tent restriction field, i.e. the field should be empty.
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3. Click the Selector button.

This time, both TEST_CASE_1 and TEST_STEP_1 are selected, be-
cause a PASS substring does not appear in the test case.

Creating a Sub Browser
It might be suitable at this point to create a sub Browser of the selection 
that you have just created (i.e. just the items TEST_CASE_1 and 
TEST_STEP_1): 

• Select Browser from the Browser Tools menu.

A sub Browser containing the selected objects is created, together 
with the necessary minimal static structure to glue them together.

You will not need this sub Browser in this tutorial so you may close 

it if you wish.

Figure 51: A sub Browser containing TEST_CASE_1 and TEST_STEP_1.
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Generating Overview Tables
To complete the test suite, you also have to generate the Test Suite Over-
view tables – that is the Test Suite Structure, the Test Case Index, the 
Test Step Index and the Default Index tables – and the TTCN Module 
Overview – that is the TTCN Module Structure and the Index tables. 

None of these tables are editable. Instead, you have to make the changes 
in the corresponding tables. The reason for this is that the overview ta-
bles should be consistent with the TTCN document. 

To generate the overview:

1. Select Generate Overview from the Browser Tools menu.

The Generate Document Overview dialog is opened. 

The TTCN suite also generates the page numbers. You can set the 
start page number in this dialog, but you do not have to do that in 
this tutorial.

2. Click the Generate button in the dialog.

3. Open the Test Case Index table.

You will see that the Description field has been generated from the 
additional Description field in the header of the test case. To make 
changes, you have to edit the tables from which the overview was 
generated and then generate the overview again.

4. Close the Test Case Index table.
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Printing the Test Suite
You should by now have a test suite that is syntactically correct and 
which includes an up to date overview. If you want to, you can print it.

Printing the Entire Test Suite
To print the whole test suite:

1. Select the entire test suite.

2. Select Print from the Browser’s File menu.

The Print Document dialog is opened.

3. Make sure that Output Device names a printer that is recognized by 
your system.

You do not have to change any other settings in this tutorial.

4. Click the Print button if you want to print the entire test suite.

Printing Parts of the Test Suite
It is also possible to print parts of the test suite.

To print, say, just the Constraint tables:

1. Select only S1 and R1.

2. Select Print from the Browser File menu.

The Print Document dialog is opened.

3. Make sure that Output Device names a printer that is recognized by 
your system.

You do not have to change any other settings in this tutorial.

4. Click the Print button if you want to print the Constraint tables.
98 gs-t3 Telelogic Tau 4.5 TTCN Suite Getting Started July 2003



 Creating Reports
Creating Reports
The Reporter tool is used for presenting status information on selected 
items in the Browser. The information may for example be analysis sta-
tus and modification date.

To make a list of the full amount of information:

1. Select the entire test suite.

2. Select Reporter from the Browser Tools menu.

The Reporter dialog is opened.

3. Set the options as shown in Figure 52, that is select all options in the 
list of actions, normal verbosity and the formatting nl + tab. The lat-
ter means that each list entry will be printed on a new line and the 
components in the list entry will be separated by tabs.

4. Click the Reporter button.

The options set in the dialog will produce the full amount of infor-
mation available, a portion of which is illustrated below:

Figure 52: The Reporter dialog
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Note that, as with all the TTCN suite log files, this file can be saved. 
This may be useful if you wish to print the file or process it with 
non-TTCN suite tools.

If you want to, you can apply the Reporter again and experiment 
with other settings.

You may also find it practical to apply the Find Table tool to text that is 
marked in the log window:

1. Mark the name of a table in the log window

2. Select Find Table from the Browser Tools menu.

The table is found and opened.

Figure 53: Test suite information
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 Exporting and Importing
Exporting and Importing
In the following examples, you will use the menu choices Convert to 
MP in the Browser and Convert to GR in the Organizer for exporting 
and importing TTCN-MP documents from and to the TTCN suite. 
However, you can also use Save As in the TTCN suite for changing the 
document format. In addition, TTCN-MP documents may be opened di-
rectly in the TTCN suite.

What You Will Learn
• To export a test suite to TTCN-MP format
• To import a test suite from TTCN-MP format

Exporting a Test Suite to MP Format
You shall now convert the test suite to TTCN-MP format:

1. Select the entire test suite in the Browser window.

2. Select Convert to MP from the File menu.

The Convert to MP dialog is opened, in which you may specify the 
name of the new document and where it is to be saved.
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3. Select the directory path in the Directories box.

4. Type the file name that you wish the exported file to be called. In 
this example the file name is Example_suite.mp.

Note the suffix .mp (used by convention). You are now ready to 
convert the file.

5. Click Convert to export the test suite.

The TTCN-MP file for the test suite can now be found in the file 
Example_suite.mp. You can check it if you like.

Figure 54: The Convert to MP dialog
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Importing a Test Suite from MP Format
Your next task is to import the TTCN-MP file that you have just export-
ed. Do not close the existing open test suite – you need that later.

1. Select Convert to GR from the Generate menu in the Organizer. The 
Convert to GR dialog is opened:

2. Select Convert TTCN MP to TTCN GR.

3. Click the folder icon of the Source MP file name field. The Select 
Source MP file dialog is opened. 

4. Click the file that you want to convert, when you have found it in 
the Files list. In this case the file is Example_suite.mp. 

5. Click OK.

6. Click the folder icon of the Destination directory for generated 
TTCN GR field. The Select Destination Directory dialog is opened.

7. Select the destination directory, i.e. where you want the converted 
document to be saved.

8. Click OK.

9. Click the Convert button in the Convert to GR dialog.

Figure 55: The Convert to GR dialog
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The file is converted and is stored in a file with a generated file name 
in the given directory. The generated file name is the MP file name 
with the extension .itex. This is shown in the Organizer log.

Now perform the following:

1. Select the TTCN Test Specification chapter in the Organizer.

2. Select Add Existing in the Edit menu in the Organizer. The Add Ex-
isting dialog is opened.

3. Select the file that you just converted (Example_suite.itex) and 
click OK.

Either type the filename and the path or click the folder button to se-
lect the file.

4. Make sure that the Show in editor option is selected.

5. Click Add.

The test suite is now added in the TTCN Test Specification chapter 
and it is opened in the Browser.

6. In the Browser, rename this test suite as Example_B.

7. Expand the entire test suite.

8. Analyze the entire test suite.

9. Do not close Example_B, you will need it in the following exercise.

Note:

You can open and work with MP-files just as you do with GR-files. 
All conversions to and from MP will then be done transparently.
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Replacing, Comparing and Merging
In this exercise you are going to merge the two test suites, the 
Example_A and the Example_B that you have just created. First you 
should change some names in one test suite though – to make it different 
– and then compare it with the other.

What You Will Learn
• To start search for a specified pattern and to replace matches
• To compare two TTCN documents
• To merge two TTCN documents

Searching and Replacing
The first thing you should do is to change some text in Example_B. The 
reason for this is that there would be no use comparing the documents 
– which you are soon going to do – if they both are the same.

You can start the search from both the Browser and the Table Editor, 
and in this case you will do it from the Browser:

2. Type 1 in the Look for field

3. Click the Search button.

The first table of the test suite containing 1 is opened and 1 is 
highlighted.

4. Type 2 in the Change to field.

6. Click the Search button again.

This will find another occurrence of 1.

1. In the Browser displaying Example_B, click the Search button.

The Table Editor will be opened, and as you can see it is empty.

5. Click the Replace button.

1 will be changed to 2 and it is no longer highlighted.
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Comparing Two Documents
When you have changed some text in Example_B, you can compare it 
to Example_A to see if any similarities exist: 

1. Ensure that the test suites Example_A and Example_B are opened.

2. Select the entire test suite Example_B

3. Select Compare from the Browser Tools menu.

The Compare Documents dialog is opened:

7. Click the Proceed button.

This is the same as first clicking Search and then Replace. Another 
occurrence of 1 will be found.

8. Click the Replace all button.

This will change all occurrences of 1 to 2. The Table Editor will 
display the table in which the final replacement was made and the 
status bar will show the total number of replacements.
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4. Make the dialog settings as depicted in Figure 56. 

This will compare the test suite Example_A with the selection that 
you made in Example_B, in this case the entire test suite.

Also make sure that Example_A is selected in the Documents field 
in the dialog.

5. Click the Compare button.

The comparison will deselect all items in the Browser for 
Example_B that do not match with items in Example_A. What re-
mains are the items that are the same in both test suites, namely the 
lower PCO L and the PDUs SEND and RECEIVE. These tables will 
also be presented in the TTCN suite log.

Figure 56: The Compare dialog
July 2003 Telelogic Tau 4.5 TTCN Suite Getting Started gs-t3 107



Chapter 5 Tutorial: TTCN Suite Basics (on UNIX)
6. Delete the selected items from Example_B.

The only items left now are the ones that differ between the two test 
suites. You are now ready to try a merge.

Merging Two Documents
The Merge tool is used for merging one TTCN document (complete or 
partial) into another. This only works on condition that the documents 
do not conflict, that is, if an item in one document has the same name as 
another item in the other document. This will not be a problem now, as 
you have already compared the documents and deleted the similarities.

The final exercise in this tutorial is that you should merge what is left of 
Example_B into Example_A:

1. Select the entire suite Example_B.

2. Select Merge from the Browser Tools menu.

The Merge Documents dialog is opened:

3. Select Example_A in the Documents chapter. That is the suite that 
you are going to merge Example_B into

4. Click the Merge button.

If you look at the Example_A Browser, you should see that the suites 
have been merged into one. This is also depicted in Figure 58.

Figure 57: The Merge Documents dialog
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Figure 58: The Example_B has been merged into Example_A
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So Far...
You should now have learned how to create a test suite and what the test 
suite looks like in the Browser. You have also learned to create and edit 
tables and how to work with the Table Editor. Other things you should 
have learned is how to analyze the test suite and how to find errors. 

Some other TTCN suite functionality that you have used are selecting, 
generating the overview, printing, making reports, converting to MP 
and back to GR, replacing, comparing and merging.

By practicing this tutorial you have probably not achieved any knowl-
edge about TTCN. If you want to know more about the basics of TTCN 
you may read the TTCN Suite Methodology Guidelines. That volume 
is, however, not a hands-on tutorial on TTCN.

The following tutorial is chapter 7, Tutorial: TTCN-SDL Co-Simulator 
(on UNIX). Before you start practising that, you should know how to use 
the SDL Simulator. A tutorial on that can be found in chapter 4, Tuto-
rial: The SDL Simulator, in the SDL Suite Getting Started.
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